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This Session TopicsThis Session Topics

How rapid development techniques will 
streamline the generation of e-Learning content
How stencils and standards ensure consistency 
among different developers
How live reviews can streamline the review 
process
How reusing learning assets can help reduce the 
development effort
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Poll: Project Resources?Poll: Project Resources?

Poll #1: What resources do you have available 
for your e-Learning projects?
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Poll: You?Poll: You?

Poll #2: Of these resources, which title do you 
typically claim?
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RWD RWD uPerformuPerform®®

RWD uPerform® is an authoring and content 
management tool for creating and delivering 
targeted learning.
RWD uPerform® authors can easily create, edit, 
and publish procedures, Adobe Flash® -based 
simulations and eLearning courses. 
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Poll: RWD Poll: RWD uPerformuPerform®® Experience?Experience?

Poll #3: How often have you used 
RWD uPerform® to create e-Learning courses?

6



Tips, Tricks, and Techniques for Rapid e-Learning Development 
December 10 & 11, 2009

Page 4Session 402 – How to Use RWD uPerform® to Streamline e-Learning 
Development - Jared Palmer, RWD Technologies

Chat Input: Rapid Development?Chat Input: Rapid Development?

Enter your opinion to the following question in the 
Chat window:
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What is rapid development?

““TraditionalTraditional”” DevelopmentDevelopment
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““RapidRapid”” DevelopmentDevelopment
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RWD RWD uPerformuPerform ®® EnhancementsEnhancements
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Value TradeValue Trade--offsoffs
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Standard Customizable

Ease of Use Programmable

Simple Complex

Case Study: Clients ProfileCase Study: Clients Profile

Client #1: Large 
hospital in Texas
Some existing content, 
some expertise not yet 
captured

Client #2: International 
precious metals 
mining corporation
Mostly existing content 
and learning assets
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Streamlining TipStreamlining Tip

Prototype “Look and Feel” and get buy-in early
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Application DemonstrationApplication Demonstration

Modifying the RWD uPerform ® template
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Content Creation/ConversionContent Creation/Conversion

Enter into RWD uPerform ® stencils
Import PowerPoint slides
Repurpose existing multimedia 
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RWD RWD uPerformuPerform ®® StencilsStencils
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Application DemonstrationApplication Demonstration

Creating content with RWD uPerform ®
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Chat Input: Existing Assets?Chat Input: Existing Assets?

Enter your opinion to the following question in the 
Chat window:
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What content pieces and 
learning resources already 
exist that you could use in 
your e-Learning courses?
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Reusing Learning AssetsReusing Learning Assets

Repurpose instructionally sound content and 
resources
Reuse existing electronic resources
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Application DemonstrationApplication Demonstration

Importing learning assets in RWD uPerform ®
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Content DeploymentContent Deployment

Learning Management System
CD-ROM
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Streamlining TipStreamlining Tip

Determine deployment method and attributes
• File size constraints for LMS upload
• Assessment scoring and recording
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Application DemonstrationApplication Demonstration

Using RWD uPerform® to publish content
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Poll: Stakeholder Reviews?Poll: Stakeholder Reviews?

Poll #4: How many stakeholder reviews do you 
conduct during an e-Learning project?
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Chat Input: Stakeholder Review?Chat Input: Stakeholder Review?

Enter your opinion to the following question in the 
Chat window:

25

How do you get 
stakeholders to review and 

provide input on the 
developed course content?

Reviewing ContentReviewing Content

RWD uPerform ® annotations
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Reviewing ContentReviewing Content

RWD Fusion Reviewer
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Reviewing ContentReviewing Content

Adobe Acrobat® PDF Review and Comment tools

28



Tips, Tricks, and Techniques for Rapid e-Learning Development 
December 10 & 11, 2009

Page 15Session 402 – How to Use RWD uPerform® to Streamline e-Learning 
Development - Jared Palmer, RWD Technologies

Streamlining TipStreamlining Tip

Have team members edit and modify the content 
directly
Have external sources review the content in the 
format that’s comfortable for them
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Application DemonstrationApplication Demonstration

Using RWD uPerform® annotations
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Thank you for your participation!Thank you for your participation!
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In traditional practice, the

storyboard is a key tool for

communication between 

e-Learning design team

members and Subject

Matter Experts. In rapid

development, however, the

storyboard is an impedi-

ment. In this week’s article,

you will learn about a tool

that eliminates the story-

board and facilitates the

rapid design process

through the use of stencils.

Using RWD uPerform to Rapidly
Design and Develop e-Learning
By Nicholas Bird

Whether you are working for an internal or ex-

ternal customer, your goal is the same: to

create instructionally-sound content with a consistent ap-

proach. Training budgets are never limitless and requests

for training often come at the last moment. So how do

you adapt to constant demands to work faster while re-

ducing the cost? Do your solutions always involve trying

to fit a square peg in a round hole? I am going to show   

you, if you are willing to do a little bit of reading, how I have learned to rapidly
design and develop e-Learning in uPerform. 

First, though, what do I mean when I say, “rapid instructional design?”
For the purposes of this article, rapid instructional design is simply the has-

tening of e-Learning content development using tools, templates, and proces-
ses. I don’t intend to validate or defend the values of rapid instructional de-
sign, or to compare rapid design to traditional instructional design methodolo-
gies. The risks attached to rapid design are well known and concerns about
them are valid.

With that in mind, it’s important not to underestimate the importance of be-
ing able to quickly create e-Learning content while maintaining instructional
soundness. The process of getting information from a subject matter expert
(SME) into an online form that a student can learn from can be daunting, to
say the least. The right combination of tools, templates, and processes can 
be a catalyst for rapid design.

A publication of

THIS WEEK: Design Techniques

The eLearning Guild’s

Practical Applications of Technology for Learning

SM
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The inspiration
For years I have been using Microsoft Word as a sto-

ryboarding tool and raving about the capabilities and
simplicity of it. The beauty of using Word is similar to
the beauty of creating Flash-based e-Learning. Word,
like Flash, is on practically every corporate desktop.
This means that my clients can easily review any cours-
es I storyboard in Word. Consider the features that
Word offers when used as a rapid design tool:

• Templates to govern the types of screens created
and the organization of content on those screens

• Quick access to templates to add new content
screens

• Text formatting features to ensure consistency
• A quick way to receive, track, collate, and respond

to client review comments
• Spelling and grammar checking
• Layout, alignment, text spacing, and other format-

ting features
• Table of contents that allows for organization and

movement of topics in the course
• Ease of use for clients to review and add com-

ments
However, not all clients can see the big picture and

one of the limitations of Word is its inability to effec-
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So what should you expect from this article?
The quality of the tools you are using has a direct

link to the speed at which you can design training. In
the past you’ve probably read articles about using
Microsoft Word as a storyboarding tool and rightfully
so. Microsoft Word, when used properly, is a solid
tool for writing and reviewing content. In an article
published in the June, 2005 issue of Learning Sol-
utions e-Magazine, “Using Microsoft Word for Rapid
Storyboard Development,” Cynthia Holmes-Radner
does a wonderful job of presenting a solid approach
for using Microsoft Word, AutoText, and a custom
toolbar to create storyboards rapidly. More recently,
Maria Leggett wrote a detailed article about using
Microsoft InfoPath and really leveraging the value of
XML. There are benefits and challenges associated
with each of these approaches.

This article will show you how I am using a new
tool (RWD uPerform) in combination with instructional
design processes that have been around for years. I
intend to demonstrate how to use the e-Learning por-
tion of the uPerform tool to rapidly design and devel-
op e-Learning by leveraging the concept of stencils. In
addition I will share lessons learned from years of us-
ing various instructional design tools for clients, and
some pros and cons of each.

Our new process
focuses on presenting
the content for a
course in a way that
provides SMEs with a
clear picture, and an
easy method for ad-
ding content and 
comments that the
designers can track.
The process culmi-
nates in the publish-
ing of SCORM-confor-
mant Flash output.



tively manage file size when the course designer adds
images. As a result, storyboards in Word are generally
not image-intensive. 

Some of our clients requested that we create story-
boards in PowerPoint so their SMEs could better vis-
ualize the final product. Our initial response to this re-
quest was to take the lessons we had learned from
long experience using Word and to apply them to
PowerPoint. This adjustment eventually led us to cre-
ate RWD uPerform.

uPerform differs from our previous methods. It elim-
inates the storyboards from the process, with content
written directly into an alpha course. The idea was to
provide our IDs (Instructional Designers) with an envi-
ronment to write in, and our clients with a look at the
actual course layout as early in the process as possible.

There is always an adjustment period as you adopt
a tool or process. Although our process did change
slightly, the underlying concept remained the same.
Previously, our IDs would:

• Take a course outline, 
• Build a storyboard, 
• Submit the document to the client for review in

electronic or paper form, 
• Incorporate comments as needed from client

SME(s), 
• Develop a beta e-Learning course complete with

graphics, interactions, audio, etc., 
• Resubmit to client for beta comments, 
• Incorporate client beta comments, and 
• Submit final course for client to place on their

training system.
This process required us to manage Flash- and

non-Flash-based files that inevitably got out of sync
with each other as we moved through each review.
Client comments often came in via notes, e-mails, text
changes in the storyboard (documented and not), and
through conversations with SMEs. Without explicit
control of the storyboard templates, the content from
one project to another could differ as to the types of
screens the designers were building. Lack of control
could also lead to a need to develop a number of
one-off Flash screens. Even though we streamlined
the process, the designers and developers had to
manually manage addition of the user interface, logos,
colors, and SCORM content.

Overview of the uPerform process 
Our new process focuses on presenting the con-

tent for a course in a way that provides SMEs with a
clear picture, and an easy method for adding content
and comments that the designers can track. The pro-
cess culminates in the publishing of SCORM-confor-
mant Flash output. Figure 1 shows the four primary
phases of the process.
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Basic concepts for building a course in
uPerform

With this process, we build, review, and update
new courses entirely in uPerform, using the Course
object to rapidly design and develop e-Learning con-
tent. The Course file contains all the content for each
page, including images and hotspots, and PowerPoint
or Flash files. But understanding stencils and their
use is the key to understanding how uPerform works.

Stencils
Most e-Learning courses use specific types of

screens. A stencil provides a rough layout of a screen
that the designer can insert where needed. Stencils
can help to define overview screens, content screens,
knowledge checks, assessment questions, and more.
Using stencils enforces design standards, ensures
coordination between instructional designers and inte-
grators and, most importantly, increases the speed

�

Figure 1
Rapid design and devel-
opment process using
RWD uPerform

Figure 2 Introduction page stencil choices
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with which designers and SMEs create e-Learning
courses.

Depending on the stencil she selects when she
begins to build a page, an instructional designer has a
number of different content options. Each stencil des-
ignates fixed areas for the page title, text, and image.
The instructional designer updates the title, enters the
text, and adds an image (or a description of the image
that a graphic artist will create later). The stencils avail-
able to the designer will vary based on the type of
page. For example, an Introduction page will have cer-
tain stencils available for use, and an Assessment
page will have a different set of stencils available.

I will demonstrate this by showing how to select a
stencil for the Introduction page of a course. Each
page that RWD uPerform generates is a construct of
a predefined stencil. As the designer begins, the first
stencil she will select will be for the Introduction page
of the course. Figure 2 on page 3 shows an example
of the stencil selection screen that uPerform presents
to the designer for the Introduction page.

Each time the designer adds a page, lesson, know-
ledge check, etc., she must fill out fields based on the
type of stencil she has added. For this example, I

picked the Standard – Half – Left stencil and named
the page uPerform Article (see Figure 2). The next
step is to insert a page title, the content for the page,
and a picture to display (See Figure 3). With a com-
pleted course introduction page, the designer is ready
to begin rapidly creating the rest of the e-Learning
solution.

Views in uPerform and the Course Layout Pane
While each stencil is different, the process of insert-

ing a page and editing or updating content is the same.
Beyond the basic page stencil concept, there are two
additional important features of the uPerform environ-

Proposals to present are now being accepted.

www.eLearningGuild.com  •  1.707.566.8990

The $200 Super-early Registration Discount expires June 22, 2007

N o v e m b e r  6  -  8 , 2 0 0 7   > S a n  J o s e

The eLearning Developers’
Conference & Expo
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Figure 3
Course Introduction page
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ment that help the designer and facilitate rapid design. 
First, uPerform offers three views for the content.

The three views are Editor, Audio, and Preview.
• Editor – This is the default view for all the work of

designing the course.
• Audio – This allows the designer to link an audio

file to the page, listen to the audio file, and add
transcript information for that page. The designer
can also check the transcript against the audio in
this window.

• Preview – This presents the content as it will ap-
pear in the finished course.

The designer can display the course objects he
has already created in the Course Layout Pane (see
Figure 4). As the designer builds the course, he will
add pages, delete pages, and will sometimes need to
change their order. In uPerform the designer can re-
arrange content by simply clicking and dragging a
course object to a new place in the sequence. She
can reorganize entire lessons with a click of the mouse.
By contrast, when using Word in conjunction with
Flash under our old process, it might take hours for a
designer to update the storyboard, communicate the
changes to the development team, and then update

the Flash source files.

The View Annotations Feature
The editable regions for each stencil let the design-

er define what the learner will see on the screen. But
designers do not work alone, and they must commu-
nicate many of the details to others on the team who
will produce content. The Instructional Designer can
use the View Annotations area to document client
requests, communicate image details to a graphic
artist, or identify which PowerPoint file to import into

Figure 4 Course Layout Pane
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the course. This area can also be an ideal location to
track other important information:

• The terminal and enabling objective that this
screen addresses;

• Any type of custom Flash SWF files that a devel-
oper needs to create;

• Information about the on-screen image and the
alternative text;

• Information about audio that the designer may
want linked to this screen; and

• Any notes for a Client/SME as they perform a
review.

Figure 5 shows what the designer sees while actu-
ally creating content; the stencil with its inserted con-
tent is on the left, the Course Layout Pane is on the
right, and the View Annotations area is at the bottom
of the screen. This is a Course Introduction page that
I created with the Standard Image stencil for a course
on effective searching. The designer can hide the
View Annotations area when she does not need it, to
allow for a larger viewing area. To toggle the View
Annotations area open or closed, the developer
selects or deselects View>View Annotations from
the menu bar at the top of the screen.

To add an annotation, the designer clicks the Click
here to create a new Annotation Set link in the
View Annotations area. Each annotation set displays
as a tab in the View Annotations area. Add more
annotation sets by right-clicking on one of the tabs. 

Each annotation set displays across all pages in
the course, but the content added for a particular
page displays only for that page. As such, a best
practice would be to use generic names for the an-
notation sets like Course Objectives, Graphic Notes,
etc.

Building a course
To begin building a course in uPerform you should

have an approved course outline, as much source
material as you can assemble, and any image files
that you intend to include in the course.

It is a good idea to begin by building the infrastruc-
ture of the course. It is easy to add, move, or delete
individual pages, so you can revise and reorganize
the course content as needed at any time. Insert a
lesson page for each lesson you will have in the course,
and an assessment page for the course. Add any
annotation sets and incorporate the content for these
pages. This will provide the structure and identify
objectives for each lesson.

Suppose you want to create a 15-minute course
on the basics of performing an effective search. Fig-
ure 5 actually shows what you might see as you use
uPerform to put this together. I will walk you through
the complete construction of the course. I'll also

show you the development of the first lesson of the
course, Search Tools, which discusses the types of
search tools, which categories the search tools fall
into, and the proper search tool to use.

Setting up the course

The first step is to create the new Course file and
name the course. (See Figure 6 on page 7.) We will
name the course “Effective Search Fundamentals.” 

After clicking the OK button, you see the Select
Introduction Page Stencil window (see Figure 2).
The introduction for this course uses the collage
graphic of various search sites that you see in Figure
5. For this purpose, the appropriate stencil is Stan-
dard – Image. Click the Add Picture… link on the
stencil and select the collage image file. 

Now you can build the course construct from the
approved course outline. The course outline shows
that there are three content lessons, a course summa-
ry, and an assessment. Before adding content, you
should add the necessary pages to the Course Lay-
out Pane. You insert course objects by selecting op-
tions from the Insert menu, by clicking a button on
the Course toolbar, or by right-clicking on an item in
the Course Layout Pane and selecting a course ob-
ject to insert. Your preference is the only factor here.
My own way to add objects is by clicking the appro-
priate buttons on the Course toolbar. Figure 5 shows
what the Course Layout Pane will look like after you
complete the steps that follow in this section of this
article.

Before the first lesson I do want to add a screen
that covers the basic details of the course including
objectives, intended audience, prerequisites, and dur-

It is a good idea to
begin by building the
infrastructure of the
course. It is easy to
add, move, or delete
individual pages, so
you can revise and
reorganize the course
content as needed at
any time. Insert a les-
son page for each les-
son you will have in
the course, and an
assessment page for
the course. Add any
annotation sets and
incorporate the con-
tent for these pages.

�

Figure 5
The uPerform designer
interface, showing a
Standard Image stencil
with inserted content,
the Course Layout Pane,
and the View Annotation
area.



A common mistake
made during the
review process is
assuming your SME
knows what you want.
Clearly setting expec-
tations with a SME is
vital to a quality review.
Communicating the
amount of time avail-
able for the review, the
areas of the course the
SME should be review-
ing, and what consti-
tutes a quality review
comment, are all criti-
cal expectations.
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ation. Click the Insert Page button, select the Stan-
dard – Full stencil, and name the page “Course
Overview.” This stencil is text only. Identify a content
title to appear on the screen and the content text for
the screen after you have completed adding the ob-
jects for the course.

The next step is to add a placeholder for each of
the lessons in the course. The lessons I will add are
titled, “Search Tools,” “Performing a Search,” and
“Other Searching Considerations.” Each lesson is
approximately five minutes long and includes a lesson
introduction, three or four content screens, a knowl-
edge check question, and a lesson summary. The
course outline specifies the type of stencils to use for
the lesson introductions, knowledge checks, and les-
son summaries. For continuity the lesson introduction
and lesson summary screens will use the Standard –
Half – Left stencil. The client has communicated that
all knowledge checks are to be multiple choice ques-
tions with no images. Based on that, you know you
need to use the Multiple Choice stencil for these.

The names you give the pages are entirely up to
you but for this course we will make all lesson intro-
ductions match the lesson title, name the lesson know-
ledge checks “Knowledge Check,” and name the les-
son summaries “Summary” in the Course Layout
Pane. When we have done this, we add an Assess-
ment object. This serves as the content screen that
appears before the learner takes the assessment. This
is good for communicating the requirements of the
assessment and any information the learner will need
to successfully complete the assessment. Since this
is an information screen, use the Standard – Full
stencil again, for the most space for text.

Building a lesson

You have successfully constructed the shell of the
course and are now ready to go back to the first les-
son and flesh out the content and the stencils you will
use. A glance at the course outline shows that there
are three content screens in the first lesson that will
need both static text and graphics. A graphic design-
er will have to make the graphics, but you need to
communicate what the graphic designer needs to
build. So before you begin adding content you want
to add an annotation for the course, called “Graphic
Notes.” This is where you will store information for the
graphic designer so he knows what image to con-
struct for each screen. Select View>View Annota-
tions and then click the associated link to create a
new annotation set. The Graphic Notes annotation
set is now visible on all screens and you can add 
specific details for each screen.

Now refer back to the course outline, gather the
pertinent details for this lesson and update the lesson

introduction screen content for the Search Tools les-
son. Each lesson introduction will consist of a few
sentences about the value of the lesson, the objec-
tives for the lesson, and the duration of the lesson.
The course does not have audio for every screen but
the outline asks for audio for each lesson introduction
screen. Recording the audio will happen later, but it is
your responsibility as the ID to provide a transcript
that tells the audio talent what to say. The audio for
this course will be a verbatim reading of the text on
the screen. Begin by copying the text in the content
area. Select Audio from the View menu. The Audio
view allows you to upload and listen to an MP3 file
and add transcript text. You can then paste the con-
tent screen text in the Transcript field. This is a plain
text field with no formatting options. If instructions are
necessary, I would suggest an Audio annotation set
to provide detailed instructions for the audio talent.

Now that you have updated the audio details, sel-
ect View>Editor to return to the course editing screen.
There are three screens to add, and since the images
will be much wider than they are tall, apply the Stan-
dard stencil type. This stencil allows for an image at
the top and text beneath. Once you have entered the
content for each page, you can go back through and
clearly identify what you are looking for in the visual.

You have now updated the lesson introduction,
added and updated the content screens for the mod-
ule, and added any graphic and audio details needed.
To complete this module, you also need to complete

�

Figure 6
Creating a new course
starts with this screen.
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the knowledge check and add the content for the les-
son summary. This knowledge check will be multiple
choice, with no image. As the ID, you can define the
instruction text the learner sees, the question stem,
and the distractors. The instructions default to “Select
the best answer to the question.” My best practice is
to typically include four distractors, in order from short-
est to longest. The stencil allows you up to six distrac-
tors and the ID can determine how many are used. To
identify the correct answer the ID selects a radio but-
ton.

To complete this lesson you need to add the con-
tent for the lesson summary. For this course the sum-
maries will include a sentence letting the learners
know they have completed the lesson, a review of the
lesson objectives, and a sentence instructing them to
click Next to continue the course.

Other things to consider

Each project is going to be different. Some will be
as simple as converting an existing PowerPoint pres-
entation quickly for distribution and tracking while 
others will include adding Flash development in the
course and more elaborate rollovers and popups.

• PowerPoint Import: There is often a wealth of
content within a company already written in
PowerPoint. As part of your rapid development
you can import PowerPoint slides directly into
uPerform. This allows you to take an existing slide
deck and quickly make it a more engaging e-Learn-
ing experience that can include interactions, au-
dio, and assessments. You can store and track
the results in a Learning Management System.

• Flash Import: The ability to import a single, self-
contained Flash file (.swf) into uPerform as a
course page allows more advanced developers to
work directly with SMEs to bring highly engaging
content to the learner.

• Image Hotspots: The uPerform Hotspot feature
allows you to specify portions of a graphic to cre-
ate a rollover effect or a simple link to a Web site.
The designer simply outlines the space for the
hotspot, sets a few characteristics, and it is done.

• Publishing: Clicking the Publish button allows
you to save and package your course materials
into a folder. In that folder are all the files (such 
as the imsmanifest.xml) and course files you will
need to add the course to your LMS.

SME review of the course
Once you have completed building the alpha ver-

sion of a course, you will need to submit the course
to the SME for review. In the past you might deliver a
printed version of a storyboard to a SME or an elec-
tronic version in MS Word using “Track Changes” to

document issues. How often does a single person
know all aspects of the training material you are devel-
oping? Normally, there are multiple people reviewing
these courses. In my experience even the best of
intentions won’t get SMEs to consolidate their com-
ments. There are inevitably comments that contradict
another SME and three versions of the same story-
board after review. The online reviewer built into RWD
uPerform eliminates these issues by allowing SMEs to
enter comments electronically that directly link to the
screen in question. You can then archive the com-
ments and sort them by the name of the person who
entered the comment.

A common mistake made during the review pro-
cess is assuming your SME knows what you want.
Clearly setting expectations with a SME is vital to a
quality review. Communicating the amount of time
available for the review, the areas of the course the
SME should review, and what constitutes a quality
review comment, are all critical expectations. Properly
aligning with your SME can be the difference bet-
ween getting a comment that says, “Replace this”
and getting a comment that identifies the exact text to
delete and the exact content the SME wants added.

These instructions do not have to be complicated.
Instruct your reviewers to clearly identify the position
of the error on the screen and a detailed action to
take. If a SME wants an additional paragraph or a dif-
ferent title, ask him to add this content in the com-
ment. The instructional designer can make sure the
information provided by the SME is reviewed for in-
structional quality. Educate clients on how to manage
multiple reviewers. If the client plans to have multiple
people review the course it is best to let the person
with final signoff review the course last, with knowl-
edge of the comments that other reviewers have made.
It can reduce the time it takes to complete the review
and ensures that multiple points of view are consid-
ered.

Finally, make sure the SME understands what con-
stitutes acceptance on his part. Many times we will
ask our clients to refrain from sending us anything
until they have completed their review. You could have
an approval document for each course, or you could
simply educate the SME that his e-mailed response,
stating he has completely entered comments on the
course, is his approval to build the course with those
edits included. The important thing is that whatever
you choose to do, the SME is aware of it and has
agreed to the process.

Final thoughts
The speed with which one can create high quality

content is obviously important. One of the primary
inhibitors that many of us have been working on is

A stencil provides a
rough layout of a
screen that the design-
er can insert where
needed. Stencils can
help to define overview
screens, content
screens, knowledge
checks, assessment
questions and more.
Using stencils enforces
design standards,
ensures coordination
between instructional
designers and integra-
tors, and, most impor-
tantly, increases the
speed with which
designers and SMEs
create e-Learning
courses.



Design Techniques

9LEARNING SOLUTIONS |  May 14, 2007

This is the first article for Learning Solutions by Nicholas Bird. The eLearning
Guild has previously published articles whose topics also relate to this week’s.
These are available to Members in the Learning Solutions Archive online. Members
must log in to download them. Here are the authors, the article topics, and the pub-
lication dates. (Not a Guild Member? Join today for immediate access to these arti-
cles and over two hundred others!)

Articles on related topics

Greg Kearsley: Department of one (April 16, 2007)
Eric Parks: The online learning content challenge (December 11, 2006)
Anita Rosen: Rapid e-Learning fundamentals (August 21, 2006)
Mike Richards: Managing project problems (April 10, 2006)
Stephanie Sanford: Team of one (January 16, 2006)
Ray Jimenez: Series on rapid design, development, and production (Five parts 

published between October 2005 and January 2006)

In the Archives

This publication is by the people, for the people.
That means it’s written by YOU the readers and members of The eLearning Guild!
We encourage you to submit articles for publication in Learning Solutions e-Mag-
azine.  

Even if you have not been published before, we encourage you to submit a query if
you have a great idea, technique, case study, or practice to share with your peers in
the e-Learning community. If your topic idea for an article is selected by the editors,
you will be asked to submit a complete article on that topic. Don’t worry if you have
limited experience writing for publication. Our team of editors will work with you to
polish your article and get it ready for publication in Learning Solutions. 

By sharing your expertise with the readers of Learning Solutions, you not only
add to the collective knowledge of the e-Learning community, you also gain the re-
cognition of your peers in the industry and your organization. 

How to Submit a Query

If you have an idea for an article, send a plain-text e-mail to our editor, Bill Brandon, 
at bbrandon@eLearningGuild.com. Refer to www.eLearningGuild.com for Author
Guidelines.

Get It Published in...

DO YOU HAVE AN INTERESTING 
STRATEGY OR TECHNIQUE TO SHARE?

eliminating the need to convert our storyboards to
Flash. Regardless of the tool you are using, the need
to copy and paste, or to apply a conversion to the
storyboards, adds time and introduces errors into the
process. I feel that uPerform improves the process for
an ID because the content you write is not manipulat-
ed in any way. Time is not spent moving content into
Flash or packaging the files for an LMS.
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